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1 GETTING STARTED 

This section provides start-up instructions for using the Oracle applications. 

 

1.1 Sign-On to Cloud applications  

To log into the application:  

1. Open internet browser window. 

2. Enter the below URL:  

No. URL Type URL Link 

1.  UAT  https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/ 

Table 1: Direct Login URL 

 

3. The Sign In page appears. Enter your User ID and Password.  

 

Figure 1: Oracle Cloud Sign-In Page 

 

4. Your user ID and password are case sensitive. Passwords always appear as asterisks 
in the display as you enter them.  

5. Tab to or click the  button to sign in. 

6. Personal Homepage dashboard screen appears with CLOUD privilege access. 
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1.2 Navigating from Personal Home Page to Applications 

 

After you log in to Oracle Applications, your Oracle Procurement Cloud Home page is 
displayed. All the functionality within the Oracle Cloud applications revolves around homepage 
which you can personalize. From here you can: 

 

1.Get a quick glance at your work-related conversations and announcements. 

2.Use the Application Link icons to navigate to pages and dashboards to perform your day-to-
day activities.  

3.Access the Navigator to access any additional applications that are not available in the 
application section on the home page 

4. Favourited list of quick actions to quickly perform some key tasks. 

 

Note: The exact appearance of your windows may vary depending on your personalization 
and roles that is assign to you. 

 

 

 

Figure 2: Personal Home Page 
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Figure 3: Navigation tools in the global area of the home page 

 

Once you have set your homepage as the Newsfeed Home Page, then it will come with 
different sections. 

 

1. Apps Section.  

 

Figure 4: Apps section 

 

Within the Apps section, you have various icons that can be used to start navigating into 
the different work areas of an application. For example, if you would like to navigate to the 
Invoices work area within Payables, you will select your application as Payables. And you 
will choose Invoices in the Apps section. When you select Invoices, the system takes you 
to the Invoices work area, where you can perform various activities, such as recording 
invoices, managing invoices, generating accounting for your invoices, etc. Once your work 
has been completed, you can go back to the home page by using the home icon. 

You can also access the apps via the Navigator.  

Here, the access is granted to various work areas based on the roles that have been given 
to your user account. You have the flexibility to personalize the App section. You can 
decide what you want to show within these springboard icons and what you want to hide. 
If you are an order regular visitor to the Payment work area, you mostly work with 
Payable’s dashboard invoices, you can hide the payments by clicking on this icon. So, it 
will not be shown in the apps icon but only accessible through the Navigator. 

 

Click this to 
personalize 
springboard 

Navigator Home Watchlist 
Settings
& Action 

Logo Favorites & recent item Notification 
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2. Things to Finish section.  

 

Figure 5: Things to Finish section 

 

The Things to Finish section provides you with a count of any pending notifications that are 
assigned to you and may require an action from you. Account Link name created by me lists 
the approval requests that you have created. You can click the link to navigate to a full list of 
notifications pertaining to that account. Then the items listed in the Things to Finish section 
are same as the notifications that are listed in the global header.  

The same information is available when you click on notifications icon. You can access the 
same number of notifications from here, as well as from the Things to Finish section. The list 
displays the latest notification first and allows you to scroll horizontally to view more 
notifications.  

You can clear a notification from the list by clicking the Close icon. When you clear a 
notification, the count does not change, since no action is taken on that notification. If you click 
on you will get a listing of all the notifications that are either FYI or the notifications that require 
an action from you. When you click on the link it opens the notification and you can get the 
details of the notification. If you are satisfied, you can either approve it or you can either reject 
it. Once the notification is read then the count will change. 
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3. Analytics section 

 

 

 

 

 

Figure 6: Analytics section 

 

As far as procurement is concerned, there are currently few choices of analytics 
display. And they are source to settle infolet, service infolet, innovate to commercialize 
infolet, plan to produce and order to cash infolets. You can personalize the Analytics 
section and decide which infolet should be visible, which should not be visible.  

 

Click on this icon to either hide 
or display a particular infolet. 

Infolets 
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1.3 Creating Favorites and Setting Preferences  

 

Creating Favorites 

Each user has their own favorites and adding favorites is easy in cloud: just go to your favorite 
work area or task page. Click on the favorite icon and click Add to Favorites.  By this you get 
to your favorite pages directly and easily when you click the favorite icon. You can remove 
unwanted pages by clicking Manage Favorites. 

 

 

 

Figure 7: Creating and Managing Favorites 

 

Set Preferences 

Select Preferences to set personal options such as regional, language, accessibility setting, 
watchlist, etc as shown in the list in Figure 8. You can also reset your password from the 
Preferences page. To get into set preferences, click on setting and action dropdown menu 
click on Set Preferences. 

 

 



Olivestouch Technologies Sdn Bhd 
User Manual 

Sourcing Module v2.0 

 

Confidential  Page 9 of 70 

 

Figure 8: Setting Preferences 

1.4 Overview of Using Work Areas to Streamline Business Processes 

 

Use work areas to gain instant insight into your business and identify potential problems with 
processing transactions.  

Work areas can include the following: 

 

• Infotiles 

• Content area 

• Action toolbar 

• Tasks panel tab 

• Process Warnings and Errors  

• Bank Statement Reconciliation 

• Process Monitor 

 

 

 

Figure 9: Budgetary Control Work Area 

 

 

 

Infotiles 

Summarize a high volume of transactional information. You can quickly identify potential 
problems and prioritize your daily activities by scanning the infotiles and accessing transaction 
details. 

For example, select an infotile to display corresponding transactional information in the content 
area. You can also click links in the infotile to filter the records in greater detail in the content 
area. 

 

Content Area 

The content area displays transactional information related to the infotile you select. You can 
review the detailed information and take the necessary action. 

For example, click the item link in the table to drill down to transaction-level information. You 
can perform multiple actions on the transaction, such as editing, approving, or rejecting the 
transaction, and posting the transaction to the ledger. 

Task Panel 

Content area 

Process Monitor 
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Actions Toolbar 

Use the actions toolbar to perform a range of activities on one or more rows you select in the 
content area. 

For example, select a transaction row and use the View menu to view the transaction in more 
detail. You can export the data to an Excel worksheet, detach the pane, approve, or reject one 
or more transactions, as well as apply additional filters. 

 

Tasks Panel Tab 

The Tasks panel includes tasks that are related to the work area and that you have access to 
perform. 

For example, create an invoice, review journal entries, create mass additions, and manage 
accounting periods within a task panel. 

 

Process Warnings and Errors 

The process warnings and errors keep previous processes history that has been run for bank 
statement loader. This area contains purge function which is available to delete error files. 

For example, select on the file then click on  button to purge and completely terminate the 
files. 

 

Bank Statement Reconciliation 

The bank statement reconciliation will provide an information of bank statement and its status 
on reconciliation. There will be two tabs which are Incomplete and Complete. 

For example, Incomplete tab listed all bank statement that consists of statement lines which 
have not yet to reconcile while Complete tab listed bank statement which have been 
completed reconciled. 

 

 

Process Monitor 

The Process Monitor is to monitor schedule process. 

For example, instead of navigating to Scheduled Processes Task, you may use the refresh 
button to keep update on the process item.  It will provide you the same info as in Scheduled 
Processes Page. 

1.5 Scheduled process 

 

 

Scheduled processes do tasks that are too complex or time-consuming to do manually, for 
example importing data or updating many records. You can run scheduled processes on a 
recurring schedule and send notifications based on how the process ends. Some scheduled 
processes give you printable output. Those processes might have Report in their name. 
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Jobs  

Each scheduled process that you run is based on a job. The job is the executable that controls 
what the process can do and what parameters and other options you have for the process. A 
job set contains multiple jobs. 

Job definitions can be set on Oracle Business Intelligence Publisher reports so that people 
can run the reports as scheduled processes. 

 

Process Sets 

A process set is a scheduled process that is based on a job set. So, when you submit a 
process set, you are running more than one job. 

 

Note: When you submit certain scheduled processes, the job logic causes other processes to 
automatically run. But in this case, you are not submitting a process set that includes those 
other processes. 

 

Submission 

When you submit a scheduled process, you can use its parameters to control which records 
are processed and how. Some scheduled processes do not have parameters. 

As part of the submission, you can also set up a schedule for the process, for example to run 
once a week for two months. Every time a process runs, there is a unique process ID. 

 

Output 

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a 
process can import records and produce output with details about those records. There are 
many types of output, for example a tax document or a list of transactions. 

 

Process Sets 

A process set is a type of scheduled process that is based on a job set and contains at least 
two processes. So, you can run many processes in one go, for a specific purpose. These 
processes run in a certain order, in serial or parallel, or by some other logic.  

Process sets can have any number of individual scheduled processes and even other process 
sets.  

 

To Submit Scheduled Processes 

 

Click Navigator > Tools > Scheduled Processes. 
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1. On the Scheduled Processes Overview page, click Schedule New Process. 

2. Leave the type as Job, enter the process that you want to submit, and click OK. 

3. In the Process Details dialog box, enter at least the required parameters, if any. 

 
Some processes have no parameters at all. Some parameters depend on other 

parameters. For example, date range parameters might appear only after you select 

By Date for another parameter. 

 
4. Click the Advanced button if you want to define the schedule, notifications, or output. 

Continue to the next steps. Or just skip to the steps for  

5. Click Submit, to run the process once as soon as possible with the default output. 

 

Define the Schedule 

Set up a schedule to run the process on a recurring basis or at a specific time. Use the Process 
Details dialog box in Advanced mode. 

 
1. Open the Schedule tab and select Using a schedule for the Run option. 

2. Select a frequency. 

3. Select User-Defined if you want to enter the exact dates and times to run the process. 

4. You can select Use a Saved Schedule to use an existing schedule if there are any. 

5. Depending on the frequency, define when the process should run. 

Define the Output 

You can choose the layout, format, and destination for your output. Use the Process Details 
dialog box in Advanced mode. 

 
1. Open the Output tab, if available. 

2. Click Add Output Document. 

3. Change the name if you want. The name identifies this output document when you go 

to view output later. 

4. Select a layout if you have more than one to choose from. 

5. Select a format, for example one of these: 

 
PDF: Is the best option if you want to print the output. 

judy.t
Highlight
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Excel: Supports embedded images, such as charts and logos, but can be opened only 

in Excel 2003 or higher. 

Data: Gives you report data in an XML file, which is used mainly for editing the report 

layout. 

 
6. Click Add Destination to send the output somewhere, for example to a printer or email 

address. You can add many destinations and send the output to all of them at the same 

time. 

 
Tip: You can also print the output as part of the steps for finishing the submission, 

instead of adding a printer destination here. 

 

To add more output documents, repeat steps 2 to 6. 

 

Set Up Notifications 

You can have notifications sent out depending on how the process ends. Use the Process 
Details dialog box in Advanced mode to set that up. 

 
1. Open the Notification tab. 

2. Click Create Notification. 

3. In the Recipient field, enter the user ID of the person you want to send the notification 

to. 

4. In the Condition list, select when to send the notification, for example when the process 

ends in error. 

5. Click OK. 

 

To send notifications to more people, repeat steps 2 to 5. 

 

 

 

 

Finish the Submission 

Follow these steps in the Process Details dialog box: 

 
1. Click the Process Options button if you want to define settings that affect the data to 

be processed. 

2. If the process gives you output and you want to print it, select the Print output check 

box and a printer. 

3. Select the Notify me when this process ends check box if you want to get an email 

notification. 

4. Enter submission notes to capture any information you want to associate with this 

submission. You can use your notes to find this submission later. 

5. Click Submit. 
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6. Click OK to confirm. 

 

Tip: Note down the process ID for your submission so you can easily find it later. For example, 
let's say you set the process to run once a week. If you later want to cancel all runs on this 
schedule, you need to cancel this original submission with this process ID. 

 

To Submit Process Sets 

 

To submit a process set from the Scheduled Processes Overview page: 

 
1. Proceed with the steps that you would follow to submit any scheduled process, but 

select Job Set for the Type option. 

2. In the Process details dialog box, set parameters for individual processes in the set. A 

process set itself does not have parameters. 

a. Select a process on the Processes tab. 

b. Enter parameters for that process, if any. 

c. Repeat for other processes in the set. 

3. Define the schedule, output, and notifications for the process set, as you would do for 

any scheduled process. 

4. Set any other options and click Submit. 

 

To Check Status 

 

1. Click Navigator > Tools > Scheduled Processes. 

The Search Results table shows processes that match the default saved search, Last 
24 hours. 

• The table might be blank if nothing was submitted. 

• If submission notes were entered when submitting the process, you can use 
the Submission Notes column to help identify the process. 

 

 

2. If you don't see the process, click the Refresh icon or use the Search section. 

3. Do any of these tasks to check on the progress of the process: 

• For more details about the status, click the status link. For example, if a process is 

in the Ready status, you can click the Ready link in the Status column to see 

where the process is in the submission queue. 

• Check the Start Time column to see if the process has started running yet. 

• In the Search Results table, find the This Job's Items Processed / Errors / 

Total column. For some scheduled processes, this column shows what's getting 

processed and how things are going.  

• Click the View Log button, especially if your process has a blank This Job's Items 

Processed / Errors / Total column. The type of information in the log varies, 
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depending on the process. You can open the log from here only for if the process 

is currently running. When the process is done, you might want to also take a look 

at the final log, if any, from the Details section. 

 

 

To view output from scheduled process 

 

1. Click Navigator > Tools > Scheduled Process. 

2. Find your scheduled process and, if you need to, refresh the search results to see the 
latest status. 

3. Select the scheduled process. 

4. Go to the Output subsection in the Details section. 

5. Click the link in the Output Name column to view or download the output, which you 
can then print. 

6. To view or export the output in a different format: 

a. Click the Republish button. 

b. Click the Actions icon. 

c. Select Export, and then select a format. 
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2 CREATE RFQ 

 

Procurement team is responsible for creating a RFQ in oracle. RFQ is a document that an 
organization submits to one or more potential suppliers eliciting quotations for a product 
or service. 

RFQs can be blind (buyer can see the quotes during the RFQ, but suppliers can’t) or 
sealed (neither buyer nor suppliers can see the quotes until the RFQ is closed) 

 

Two Stage RFQ 

The two-stage RFQ process involves the submission by the suppliers of a technical quote 
and a commercial quote. The technical quotes are opened and evaluated first to determine 
a list of qualified suppliers, and only then are the commercial quotes of the qualified 
suppliers opened and evaluated. 

 

 

No. Work Area Navigation 

1.  Procurement   Purchase Orders 

Table 2: Navigation 

 

2.1 Create RFQ 

No. Steps 

1.  Click on Task  

 

2.  Choose Process Requisition 

 

 

 

 

 

 

judy.t
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3.  Enter the parameter and click Search button. 

 

 

Click Add to Document Builder 

 

4.  

 

 

5.  Type Enter Type : RFQ 

6.  Negotiation Type Enter Negotitation Type : Two Stage Negotiation/Standard 
Negotiation 

judy.t
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7.  Negotiatation 
Template Enter negotiation template if Prourement Team already define 

predefine template.  

8.  Outcome Enter Outcome 

9.  Click OK button 

10.  Review the detail of the information. 

Click Create Button 

 

11.  Enter Cover Page Information 
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12.  Click Next. 

Enter Overview Information 

 

Go to General Tab 

Add attchment if required 

 

 

 

13.  Define the Schedule 

Define Negotiation Controls 

Define Requirements 



Olivestouch Technologies Sdn Bhd 
User Manual 

Sourcing Module v2.0 

 

Confidential  Page 20 of 70 

 

 

14.  
Negotiation Dates 

Preview Date - During the preview period, all eligible suppliers may view the RFQ but not 
submit responses. 

Open Date - The date and time the negotiation opens. 

Close Date - The date and time the negotiation closes. Once closed, no further responses 
may be accepted. 

Award Date - The date and time by which RFQ/auction will be awarded. While buyers are 
encouraged to honor their award dates, the system does not enforce these dates. 

Response Visibility 

Blind - Only the buyer can see the quotes/bids. 

Sealed - The buyer can see the responses when the negotiation is unlocked. Both the buyer 
and suppliers can see the responses when they are unsealed. 

15.  When calculating scores for supplier responses, there are three possible methods: 

Automatic scoring - The scores for responses are calculated by the application. When 
defining the negotiation. 

Manual scoring - When defining the negotiation, you don't define any score values. With 
this method, you (and any scoring team members) view the supplier response and enter 
scores yourself. 

None - if the scoring method is None, no scores are calculated by the application or 
assigned by anyone. 

 

16.  
Go to Terms 
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If the negotiation required response from overseas supplier, buyer need to tick allow 
responses in other currencies and define response currency. 

 

 

 

 

17.  
Go to Collaboration Team. 

Enter Team member 
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Set Access 

Enter Task 

Choose the target date 

 

 

18.  
Click Manage Scoring 

 

19.  

 

20.  

 

Click + Icon 

Enter Information for Scoring Team 

judy.t
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User can set scoring deadline for the technical and commercial scoring team 

 

 

 

21.  
Verify the information 

Save and Close 

22.  
Click Done 

judy.t
Highlight
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23.  
 

 

24.  
Click Next Button 

25.  
Enter Technical and Commercial Requirements Detail 

 

 

26.  
Click Add Section 

 

 

27.  
Enter Section Information 

 

 

28.  
Click Add Requirement 

 

 

29.  
Enter Requirement Information 
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Define the Scoring Method, Weight and Maximum Score. 

Requirement scores can also be weighted to more accurately reflect their importance within 
the negotiation. 

 

User can set the response options during supplier response. 

 

 

Attachment options can be set for specific requirements. 
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30.  
Review the requirements entered. 

 

 

 

31.  
Add Section and Requirement if you have additional information 

Click Save and Close  

32.  
Click Next Button 

33.  
Go to Lines Information 
The information created is from Purchase Requisition. 
 

 
 

 
 
Note to Suppliers : This is to highlight any information to supplier for example to elaborate 
the details of the item. 
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34.  
Click Next 

35.  
Click Search and Add 

 

36.  
Enter Supplier Parameter and Search 

 

37.  
Choose Supplier Name and Click Add to Selection 

 

38.  
Choose another supplier for this Negotiation 

 

39.  
Click Continue 
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40.  
The information will be defaulted from supplier setup. 

If the supplier have more than 1 supplier site, then user need to choose the Supplier Site. 

 

41.  
Click Next 

User can Save or directly publish the RFQ. 

 

42.  
Review the Negotiation  

Click Publish 

 

Table 3: RFQ Creation 
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Negotiation/RFQ Status Explanation 

Draft The initial status of the negotiation. Also the status 
of the negotiation after it's rejected. In this case, 

the category manager can edit and resubmit the 
negotiation document. 

Approval in process The negotiation document is in the process of 
being approved. 

Submitted The negotiation document has been approved, 
but the preview or open date is in the future. 

Withdrawn The negotiation document has been withdrawn 
from the approval process by the category 
manager. 

Approved (not published) The negotiation document has been approved but 
can't be published because the open or close 
dates 

have expired, or there was an error in publishing 
the negotiation. The category manager can use 
the 

Modify Schedule dialog box to enter new dates 
and publish the negotiation. 

Active The negotiation document has been approved is 
accepting responses. 

Rejected The negotiation document was rejected by one or 
more of the approvers. The category manager can 

edit the document and resubmit it. 

Table 4: Negotiation Status 
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2.2 RFQ Approval 

 

Click the Notifications (Bell icon) at the top right of the page. 

 

System Notifications 

 

Figure 10: Approver System Notifications RFQ 

 

Email Notifications 
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Figure 11: Approver Email Notifications RFQ 

 

 

No. Steps 

1.  Approver can review detail of the RFQ information before approve. 

 

2.  Click Approve or Reject 

 

Table 5: RFQ Notification 
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3 CREATE RESPONSE 

 

No. Work Area Navigation 

1.  Supplier Portal  Supplier Portal 

Table 14: Navigation 

This section is focus on how supplier create response through supplier portal. Once RFQ has 
been approved and published, then supplier will receive the notification. They can respond to 
the negotiation through supplier portal if user already have access to supplier portal. Supplier 
will initially acknowledge the RFQ. 

 

No. Steps 

1.  Go to Negotiations 

 

2.  Supplier may see the list of active negotiation 

 

3.  Each negotiation in the system has multiple sections. To view each section, click on the 
corresponding link in the Table of Content. 

 

4.  

Supplier can view attachment from buyer for example Terms & Condition 
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5.  All files attached to the negotiation are listed on the Attachments page. 

Supplier can download. 

 

6.  Supplier can click Acknowledge Participation to an ongoing negotiation that they interested.

 

7.  

 

 

 

8.  Create Response 
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 Refer Overview tab and enter information 

 On each page the Time Remaining and Close Date is presented. These date are 
indicating the deadline for the quote submission. 

 

 

 

Supplier can attach file during the response submission. 

 

9.  Refer Requirement Tab 

Suppliers will answer negotiation questions (Requirement) 

 Response Required: When a question is marked by a start, it means that answering the 
question is mandatory to submit the quote response. 

 



Olivestouch Technologies Sdn Bhd 
User Manual 

Sourcing Module v2.0 

 

Confidential  Page 35 of 70 

 

 

 

 

 

 

 

 

 

10.  Refer Lines Tab. 

Supplier will enter price offer in response price. 

 

 

 

Suppliers need to enter the details of the specification for line purchase at Note to Buyer. 

 

Suppliers can review the response by clicking Review. Once the response is validated, click 
on Submit button. 
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11.  

  

Table 6: Creation Supplier Response 
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4 CREATE EVALUATION 

 

To proceed with the evaluation, the RFQ status should be closed. The close date is defined 
during RFQ Creation. Procurement has the option to advance close the RFQ if required. 

 

No. Work Area Navigation 

1.  Procurement Negotiations 

Table 7: Navigation 

 

4.1 Close RFQ 

 

No. Steps 

1.  Click on Task  

 

2.  Click Manage Negotiations 

 

 

3.  Search and Open the RFQ 

 

 

4.  Click Actions 

Click Manage 

Click Close 
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5.  Click Submit button 

 

6.  

 

Table 8: Close RFQ 
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4.2 Manage Collaboration Teams 

 

No. Steps 

1.  Click on Task  

 

2.  Click Manage Negotiations 

 

 

3.  Search and Open the RFQ 

 

4.  Click Actions 

Click Manage 

Click Manage Collaboration Team 

 

 

5.  Choose team member and send notifications. 

Evaluators will receive the notifications. 
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Table 9: Manage Collaboration Teams 

 

 

 

 

4.3 Unlocked and Unsealed Technical Stage 

 

 

No. Steps 

1.  Click on Task  

 

2.  Click Manage Negotiations 

 

 

3.  Search and Open the RFQ 

 

4.  Click Actions 

Click Manage 

Click Unlock Stage: Technical 
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5.   

 

Click Yes 

 

6.  

 

Click OK 

7.  The status change to Evaluation in Progress: Technical (Unlocked) 

 

8.  Click Actions 

Click Manage 

Click Unseal Stage: Technical 
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9.  

 

The status change to Evaluation in Progress: Technical (Unsealed) 

Table 10: Unlocked and Unsealed Technical Stage 

 

 

 

4.4 Online conversation with supplier 

 

This function is used when collaboration teams want to communicate with supplier via online. 

 

No. Steps 

1.  Click on Task  

 

2.  Click Manage Negotiations 

 

 

3.  Search and Open the RFQ 
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4.  Click Messages 

Click ‘+’ icon 

 

 

 

5.  Enter message information 

Click Send 

 

  

6.  Supplier will receive the notification 
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Click Reply to Message 

It will automatically link to the login page. 

Suppliers enter username/password. 

7.  Supplier reply by click Reply button. 
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8.  Enter messages. 

 

 

Click Send button. 

Table 11: Online Message with supplier 
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4.5 Scoring RFQ 

 

. 

No. Steps 

1.  TBE Evaluator runs TBE form from Reports and Analytics. 

 

 

 

Click 

Enter parameter to view on specific RFQ. 

 

 

Click Export and choose Excel. 

 

Amend the TBE Form by adding the signature part. 

After TBE form is completed then LSE can proceed for TBE Seating. 

 

2.  After supplier is selected, then TBE user can login into oracle to enter the result and scoring. 

3.  Click on Task  

 

4.  Click Manage Negotiations 
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5.  Search and Open the RFQ 

 

6.  Click Actions 

Click Manage 

Click Open Scoring 

 

 

 

 

7.  

 

Click OK 
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8.  Click Actions 

Click Analyze 

Click Score Responses 

 

 

9.  TBE Evaluator can proceed to perform technical evaluation  

Click icon 

 

 

10.  Enter score for supplier 

 

 

TBE users can attach TBE form during scoring by clicking Scoring Attachments. 
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11.  User can view Scoring Progress – In Progress 

 

12.  User can view scoring progress – Completed 

 

 

13.  The buyer will complete the technical evaluation stage. 

Click Actions 

Click Manage 

Click Complete Stage: Technical 

 

 

14.  Click Yes 



Olivestouch Technologies Sdn Bhd 
User Manual 

Sourcing Module v2.0 

 

Confidential  Page 50 of 70 

 

 

15.  

 

Click OK 

16.  
 
The status will change Evaluation Completed: Technical (Unsealed) 

 

17.  
Unlock Stage Commercial 

 

18.  
Click 
 

 

19.  
Click OK 
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20.  

 

21.  
 

 
 
 

22.  

 

23.  
 

 

24.  

 

25.  
 

 
 

26.  
Status of RFQ change to Evaluation in Progress: Commercial (Unsealed) 
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27.  

 

28.  
Purchasing User can start with commercial evaluation. 

 

29.  
 
 

 

30.  
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31.  
 

 

32.  

 

33.  

 

Table 12: Scoring RFQ 
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5 AWARD 

 

No. Work Area Navigation 

1.  Procurement Negotiation 

Table 13: Navigation 

 

5.1 Award Supplier 

 

No. Steps 

1.  Click on Task  

 

2.  Choose Manage Negotiations 

 

3.  Search and open the RFQ

 

4.  Click Actions 

Click Manage 

Click Award Negotiation 
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5.  

 

User can perform partially award by choose at line level. 

6.  
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7.  

 

8.  Save 
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9.  

 

10.  

 

11.  

 

12.  

 

Click Submit for Approval 

13.  
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Click OK 

The award will go for approval processes. 

Table 14: Award Process 
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5.2 Award Approval 

 

Click the Notifications (Bell icon) at the top right of the page. 

 

Systems Notifications 

 

Figure 12: Approver System Notification Award 

 

 

Email Notifications 
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Figure 13: Approver Email Notifications Award 

 

 

No. Steps 

1.  Approver can review detail of the Award Decision before approve. 

 

2.  Click Approve or Reject 



Olivestouch Technologies Sdn Bhd 
User Manual 

Sourcing Module v2.0 

 

Confidential  Page 61 of 70 

 

 

Table 15: Award Approval Notification 

 

 

5.3 Complete Award 

 

No. Steps 

14.  Click on Task  

 

15.  Choose Manage Negotiations 

 

16.  Search and open the RFQ

 

17.  Click Actions 

Click Manage 

Click Complete Award 
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18.  

 

19.  

 

20.  

 

21.  

 

Table 16: Complete Award 
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6 NEW ROUND RFQ 

 

6.1 Create new round RFQ 

 

 

No. Work Area Navigation 

1.  Procurement   Negotiations 

Table 17: Navigation 

 

 

No. Steps 

1.  Click on Task  

 

2.  Choose Manage Negotiations 

 

3.  
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4.  

 

5.  RFQ number will be generated from initial with revision. 

 

6.  

 

7.  
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8.  Information will be carried from previous response. 

 

9.  

 

10.  Click Submit button 

 

11.  System will prompt error if supplier put the response price lower than the start price. 

 

 

Table 18: New Round RFQ 
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7 SURROGATE RESPOND 

 

7.1 Create Surrogate Respond 

 

No. Work Area Navigation 

1.  Procurement   Negotiations 

Table 19: Navigation 

 

A surrogate response is a negotiation response that you enter on behalf of a supplier 
company. This feature gives the buying organization the ability to capture responses from 
suppliers who are not able to directly enter their responses online. 

 

No. Steps 

1.  Click on Task  

 

2.  Choose Manage Negotiations 

 

3.  Click Actions 

Click Manage 

Create Surrogate Response 
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4.  Enter Supplier Name and Supplier Contact 

Click Create Button 

 

5.  Enter Create Response Information 

 

6.  Response Received On   Enter Response Received On 

7.  Click Next Button 
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8.  Go to the section field   

 

 

9.  Click Next Button 

10.  Enter Response Price 

 

11.  Click Next Button 

12.  Review Response and Submit 

 

13.  

 

Click Yes Button 

Table 20: Create Surrogate Respond 
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8 FREQUENTLY ASKED QUESTIONS/ SPECIFIC SCENARIOS 

 

8.1 Scenarios related to attachment during RFQ 

 

 

1. Go to attachments if user want to add any attachment 

2. Click  icon 

3. Please ensure to choose Category as To Supplier 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 QUESTION 

LSE want to attach attachment during RFQ processes. For Example LSE Terms and 
Conditions. 
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